Table of Contents

1 Introduction .................................................................................................. 1
2 Installing and Starting Software .................................................................. 1
3 Using the Software ..................................................................................... 6
   3.1 New ........................................................................................................ 6
   3.2 Close ....................................................................................................... 7
   3.3 Save ......................................................................................................... 8
   3.4 Save As .................................................................................................. 9
   3.5 Save Reports as PDF ........................................................................... 9
   3.6 Open ....................................................................................................... 10
   3.7 Print ....................................................................................................... 11
   3.8 Print Setup ............................................................................................ 16
   3.9 Exporting Data ..................................................................................... 16
   3.10 Exit ....................................................................................................... 17
   3.11 Edit Patient Profile ............................................................................. 18
   3.12 Edit Clinical Details ........................................................................... 18
   3.13 Edit Patient Notes ............................................................................... 19
   3.14 Edit Long Term Report ...................................................................... 19
   3.15 Using a miniSD or SD Card ................................................................. 20
   3.16 Download via USB cable .................................................................... 21
   3.17 Help ..................................................................................................... 25
   3.18 Set Device ID ...................................................................................... 26
   3.19 Set Clock ............................................................................................. 26
   3.20 Change Device Settings ...................................................................... 27
   3.21 Patient Profile Tab & Clinical Details Tab .......................................... 28
   3.22 Patient Notes Tab ............................................................................... 29
   3.23 Total Time Tab .................................................................................... 30
   3.24 Compliance Tab .................................................................................. 31
   3.25 Detail Data .......................................................................................... 32
   3.26 Long Term Data .................................................................................. 34
1 Introduction

The Easy Compliance Software is compatible with Apex’s CPAP System which is intended for the treatment of patients with Obstructive Sleep Apnea (OSA).

The Easy Compliance Software is used with Windows® based PCs and allows you to download usage data collected by the Apex’s CPAP device after treatment. The memory capacity in the Apex’s CPAP system can hold up to 730 sessions of summary data.

To ensure proper use of the software, please read all instructions prior to downloading data from the Apex’s CPAP.

2 Installing and Starting Software

■ Preparations

1. Make sure your PC is running on Windows® based system. It will not run on Mac systems.
2. There are two steps to the software installation:
   i. Download the Easy Compliance software from the CD onto your hard disk.
   ii. Install the USB drivers for the Apex’s CPAP.

■ System requirements

Your computer must meet the following requirements:

- Available Windows® supported USB port (USB 2.0)
- Pentium-class processor; Pentium III 800-megahertz (MHz) or higher is recommended.
- Microsoft Windows® XP SP2, Windows® Vista SP1, or Windows® 7 (32 bit).
- 128 MB RAM.
- CD-ROM drive compatible with multimedia desktop computer specifications.
- 1024 x 768 or higher resolution VGA monitor.
- Minimum 100MB hard disk space for software and data.
- Internet Explorer 7 or greater

■ Steps to Download Easy Compliance software from the CD onto the hard disc.

1. Close all applications before installation.
2. Put the Easy Compliance CD into your computer’s CD-ROM drive.
3. The installation program window will automatically pop up (if not, find the installation program in the CD and double-click it). The program will guide you through five steps required to install drivers and Easy Compliance Software on your computer. After the program finishes one step, press the button for next step to complete the installation.
Step 1: Install USB-to-Serial: CDM Driver

Step 2: Install USB-to-Serial: PL2303 Driver

Note: Once this step is executed, PC will display the PL-2303 USB-to-Serial InstallShield WiZARD. It will guide you to complete the installation of the PL-2303 driver. If this driver has already been installed in your PC, just press “Cancel” button on the InstallShield WiZARD to skip this step.

Step 3: Install PDF creation

Step 4: Install Easy Compliance Software

Note: Once this step is executed, PC will display the Setup WiZARD. Following the instructions will guide you to complete the installation of the Easy Compliance Software.
In the “Destination folder” box, you can type in a directory path or press the “Browse” button to establish a folder and path on your hard disc that will contain the software. The default path is “C:\Program Files\Apex Medical\Easy Compliance 3.2\”. Press the “Next” button to complete the installation. Once the installation process is complete, click “Close” button to exit the program.

Step 5: Installation complete and exit

Note: Once the installation is completed, a confirmation message to ask you to re-start the PC will pop up.
**Install Software**

The software icon will appear in the folder where you installed the software and also on the desktop.

**Installing the USB drivers for Apex’s CPAP**

The USB driver should be installed automatically after the setup program is completed. For the first time to connect the device to PC with the USB cable, the message box below may appear. Found New Hardware Wizard starts when Windows finish searching for the new hardware. Windows will ask you if it can connect to Windows Update to search for software. Select "Yes, this time only" then click "Next".

![Found New Hardware Wizard]

When the window below appears, select "Install the software automatically (Recommended)" then click "Next".

![Found New Hardware Wizard]

The Found New Hardware Wizard will start to search the hardware and show window below.
During the search process, there may appear the warning message window below, click "Continue Anyway" to continue installation. The driver installation starts.

Click "Finish" to complete the installation. Now you can download the data via USB Cable.

Note: Some systems may need to restart the computer to complete the installation of the driver.

- **Starting the software**

  To use the software, double-click on the software icon 🏡 A new file will be displayed, and all software functions can be accessed.
3 Using the Software

3.1 New

If you would like to create a file for a new patient, click the “New” Toolbar button or click “File” on the Menu Bar and then select the "New" item from the drop-down menu. Note that when you first start the software, the screen will already have a blank patient profile available (no need to press the “New” button).

File -> New

Note: Before downloading new user data, it is necessary to have a patient file open first (create a new file, open an existing file or have a blank profile on the screen). Otherwise, the download function will fail.
When you open a new file, the main window with empty patient record will pop up. The functions of the various parts of the main window are described below:

**Patient Record**
There are seven tabs in patient record to present the data of patient profile, clinical details, patient notes, total usage time, compliance usage time, detail and long term report. (Some models may not have the detail tab.)

**Menus**
From the menus user can perform several functions to load/save file, edit patient record, download data from CPAP device, and see help file.

**Toolbar**
Users also can quickly perform the functions of menu by clicking ten icons.

### Icon meaning

#### 3.2 Close

If you would like to close the current patient file, click “File” on the Menu Bar and select the "Close" item.

Once you execute this function, the current window will be closed and you will be asked to confirm whether you would like to save the current data or not. It is recommended that you save data before closing the patient file.
Confirmation during the Close function

After closing the patient file, the main window will be displayed.

Main Window

3.3 Save

If you would like to save the current data to the hard disk, click “File” from the Menu Bar and then select the "Save" item. You can also press the “Save” Toolbar button.

File - > Save
3.4 **Save As**

Click “File” from the Menu Bar and then click “Save As” to save data to another file.

To save the current data to a different filename, type a new name into the “File name” box and click the “Save” button.

3.5 **Save Reports as PDF**

If you would like to save usage data reports as an electronic file, click on “File” from the Menu Bar and then “Save Reports as PDF”. All the usage data during the selected period will be converted into a PDF file.
3.6 Open

If you would like to open an existing file, click “File” from the Menu Bar and then select the “Open” item. You can also press the “Open” Toolbar button.

1. When you select the “Open” item, the Open dialog box will appear.
2. Search for your file (with .paf extension) in the dialogue box and select it by double clicking on it.
3. By default, the Main Window will display the Patient Profile screen for the selected patient data.
3.7 Print

If you would like to print the current window, click on “File” from the Menu Bar and then “Print”. You can also press the “Print” Toolbar button.

When you select the “Print” function, a dialog box appears allowing you to select the reports to be printed. You can choose to preview the content before printing or to convert the report to a PDF file.
## Summary Report

### Patient Profile

<table>
<thead>
<tr>
<th>Name</th>
<th>Sleep Apnea</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID No</td>
<td>123456789</td>
</tr>
<tr>
<td>Chart No.</td>
<td>123 ZZZ AAA</td>
</tr>
<tr>
<td>Sex</td>
<td>Male</td>
</tr>
<tr>
<td>Date of Birth</td>
<td>/</td>
</tr>
<tr>
<td>Phone No.</td>
<td>Sleep Lab</td>
</tr>
<tr>
<td>Cell Phone</td>
<td></td>
</tr>
<tr>
<td>Address</td>
<td>XXX</td>
</tr>
<tr>
<td>Physician</td>
<td>Sleep Lab</td>
</tr>
<tr>
<td>Equipment</td>
<td>Apox</td>
</tr>
<tr>
<td>Insurance Co.</td>
<td></td>
</tr>
</tbody>
</table>

### Clinical Details

<table>
<thead>
<tr>
<th>Weight</th>
<th>65 kg</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height</td>
<td>176 cm</td>
</tr>
<tr>
<td>Neck Circum</td>
<td>40 cm</td>
</tr>
<tr>
<td>BMI</td>
<td>27.8</td>
</tr>
<tr>
<td>Blood Pressure</td>
<td>mmHg/mmHg</td>
</tr>
<tr>
<td>Red Time</td>
<td>35.35</td>
</tr>
<tr>
<td>Average Sleep Hours</td>
<td>6 hr</td>
</tr>
</tbody>
</table>

### Efficacy Statistics

<table>
<thead>
<tr>
<th>Average AH1</th>
<th>5.12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Pressure</td>
<td>7.6 cmH2O</td>
</tr>
<tr>
<td>Average 90th percentile Pressure</td>
<td>77 cmH2O</td>
</tr>
<tr>
<td>Average Leak</td>
<td>35.8 psi</td>
</tr>
<tr>
<td>Average Time with Large Leaks</td>
<td>0.5 min</td>
</tr>
</tbody>
</table>

### Compliance Time

<table>
<thead>
<tr>
<th>Selected Period</th>
<th>2016/01/21 - 2016/02/23</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total days</td>
<td>123 days</td>
</tr>
<tr>
<td>Compliant With Usage</td>
<td>400.9</td>
</tr>
<tr>
<td>Min Compliance</td>
<td>2.4</td>
</tr>
<tr>
<td>Max Compliance</td>
<td>9.0</td>
</tr>
<tr>
<td>% of Utilization Days</td>
<td>100.0%</td>
</tr>
</tbody>
</table>

### Patient Notes

<table>
<thead>
<tr>
<th>NO.</th>
<th>Date and Time</th>
<th>Notes (50 characters per line)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

*Summary Report*
Compliance Time Report, with limited 90 days of data
Data: 06/11 00:33

Pressure Events Per Hour

| Time (Hr) | 4 | 5 | 6 | 7 | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 | 18 | 19 | 20 |
|-----------|---|---|---|---|---|---|----|----|----|----|----|----|----|----|----|----|
| Asleep    |   |   |   |   |   |   | 343|    |    |    |    |    |    |    |    |    |
| AHI       | 2.0| 3.3| 3.8| 4.4| 5.4| 6.6| 7.1| 8.6| 9.4| 10.3| 11.4| 12.5| 13.6| 14.7| 15.8| 16.9| 17.0|
| Apneas    | 0.0| 0.0| 0.0| 0.0| 0.0| 0.0| 0.0| 0.0| 0.0| 0.0| 0.0| 0.0| 0.0| 0.0| 0.0| 0.0| 0.0|
| Hypopneas | 12.0| 12.3| 12.6| 12.9| 13.2| 13.5| 13.8| 14.1| 14.4| 14.7| 15.0| 15.3| 15.6| 15.9| 16.2| 16.5| 16.8|
| Respiratory Snoring | 0.0 | 0.0 | 0.0 | 0.0 | 0.0 | 0.0 | 0.0 | 0.0 | 0.0 | 0.0 | 0.0 | 0.0 | 0.0 | 0.0 | 0.0 | 0.0 | 0.0 |
| Total AHI | 9.4|    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |

Daily Detail Report
Long Term Trend Report, with limited 90 days of data shown in the pressure graph.
3.8 Print Setup

If you would like to adjust the printing options, go to “File” (Menu Bar) -> “Print Setup”. You can adjust paper size, printer, landscape etc.

File - > Print Setup

3.9 Exporting Data

If you would like to export the long term summary data from the existing patient file to comma separated value (CSV) files for use with other programs, go to “File” (on Menu Bar) -> Export.

Before exporting data to CSV files, you need to open an existing file. From the File menu, choose Export. The Export to CSV File dialog is displayed. Select data you need and the date range from which to generate the CSV files. Type the file name and save the CSV files in a directory path.

Export to CSV File
3.10 Exit

If you would like to exit the Easy Compliance software, go to “File” (on Menu Bar) -> Exit.

When you exit the software, you will be asked to confirm whether you would like to save the current data or not. It is recommended you save all data before exiting.
3.11 Edit Patient Profile

If you would like to edit the patient profile data, click on “Edit” from the Toolbar buttons and then select the “Patient Profile” tab towards the top of the “Patient Information” window. A patient profile edit window will then display. Simply fill in or update the appropriate information and click the “OK” button.

3.12 Edit Clinical Details

If you would like to edit the clinical data for the patient, click on “Edit” from the Toolbar buttons and then select the “Clinical Data” tab towards the top of the window. Simply fill in or update the appropriate information and click the “OK” button.
3.13 Edit Patient Notes

You can also add or edit the Patients Notes. When the Edit Patient Notes screen appears, click on any of the available 20 lines that you want to enter data for. The maximum number of Patient Notes is 20.

![Edit Patient Notes](image1)

3.14 Edit Long Term Report

The Edit Long Term Report function allows you to change the parameters for the Long Term Report (one of the Information Tabs at bottom of main screen).

Go to Long Term Report tab and click “Time Edit”. Here, you can configure the date range that the report covers. You can also modify the Minimum Compliance hours, which is used to calculate the percentage of days that the patient reached the “Minimum” hours of treatment (also reported on the Long Term Report).

![Time Edit](image2)

![Edit Analysis settings](image3)

The date range selection only applies to the Long Term Report and will not affect the data on the “Total Time” or “Compliance” Information Tabs.
3.15 Using a miniSD or SD Card

The patient can use the miniSD or SD card to backup the most recent compliance data in the Apex’s CPAP system (for some models). Once the data is backed up, the patient will send the miniSD or SD card to you and the compliance data can be retrieved and analyzed using the Easy Compliance software.

Insert the miniSD or SD card to the card reader connected to your PC. Click the “Card” icon to open the files saved in the miniSD or SD card. The files of type is “CPAP SD Card Files (*.cpe) or APAP SD Card Files (*.ape).
3.16 Download via USB cable

This section describes how to download data from the Apex’s CPAP to your PC.

To download data, there are three steps to follow –

Step1. Connect Apex’s CPAP device to your computer with USB cable.
Step2. Start the software and establish an internal connection (between the CPAP system and PC).
Step3. Download data.

Each step is described in detail below.

---

**Step1: Connect Apex’s CPAP device to your computer with USB cable.**

1-1. Plug the power cord into the power socket of the Apex’s CPAP device. Plug the other end of the cord into a wall outlet. Keep the CPAP system in Standby mode (no airflow). Download will fail if the device is providing airflow.

1-2. Connect the Apex’s CPAP device to your computer using the USB cable supplied in package. The Mini-USB end (the smaller end) is for the CPAP system and the standard USB end (the larger end) is for the computer.

1-3. Start the software on the PC by double-clicking on the icon in the software directory.

---

**Step2: Start the software and establish an internal connection (between CPAP system and PC).**

Aside from the physical cable connections, it is necessary to establish another internal connection between the two devices, which is done through the PC’s Serial Ports (not to be mistaken for the physical Serial connectors).

In most cases, you can have the software automatically establish these connections as follows:

2-1. Click on the "Download" item in the Menu Bar and select the “COM port Auto Connect” item.

2-2. The Software will automatically detect an appropriate connection for you.

2-3. If the connection was established successfully, the message “Auto Connect Successful” will appear. Otherwise, the message “Auto Connect Fail” will appear.
-- PC fails to connect automatically --

If the internal connection to the CPAP system fails, check the following:

- Check if the power cord is securely attached to the Apex's CPAP device, and the CPAP device is in standby mode.
- Check if the connecting cable is securely attached to the CPAP system and the computer.
- Check the USB driver on the PC. Go to the Device Manager in your system to determine the appropriate driver installation steps. Open the Device Manager (located in "Control Panel\System" then select the "Hardware" tab and click "Device Manager..."), and select "View > Devices by Type" to make sure the device you install is correctly displayed. The device appears as an additional COM port with the label "USB Serial Port". If you don’t find an additional "USB Serial Port", try to reinstall the USB driver.

**Manually set Connect setting**

You can also manually set the connection setting but you must know the correct COM port number which Apex's CPAP device uses. Check Device Manager in your system to find the correct COM port number. Select "View > Devices by Type," and under "Ports (COM & LPT)," look for a USB Device with “Prolific USB Serial Port (COMn).” Note that n is the number of the COM port assigned to the Apex's CPAP device.

2-1. Go into “Control Panel”>System and click the Device Manager button on the Hardware tab
2-2. Select the menu “COM & LPT," and find the COM port of “Prolific USB Serial Port (COMn)”. Right mouse click (or double click) for the “Properties”
2-3. Select the Port Settings Tab. Click the Advanced button.
2-4. Manually set the COM Port number.
2-5. Go back to the menu bar of Easy Compliance and select correct COM port, and click “OK” button to confirm.
Click “Device Manager”

Select “COM & LPT” and find “Prolific USB Serial Port”. Right mouse click (or double click) for the “Properties”.

Select the Port Settings Tab. Click the Advanced button
Step 3: Start to Download

3-1. To download the patient data from Apex’s CPAP device, click on "Download" from the Menu Bar and select the “Extract Data” function; the user’s therapy data will be copied to your computer’s memory (you can also click the “Download” Toolbar button).

Note that after a download, the data on the Apex’s CPAP system will not be removed. Data in Apex’s CPAP system can only be erased through the control panel on the device.

While downloading data, a progress indicator displays the percentage of data retrieved.
Once the data retrieval process has been completed, click “OK” and the Patient Profile screen will appear with the new information.

Software fails to download the data
If the connection to the CPAP Device fails, you will be informed by an error message. Please check the following:
- Check if the Apex's CPAP device is powered on and in standby mode.
- Check if the USB cable is secured at both ends.
- Check if the connection between CPAP device and the computer is established by following Step 2 described above.

To stop the download, simply press the Close button in the top right corner of the progress window.

Important: Every time you download data to an existing patient file, all existing usage data for that patient will be erased. So, if it is important to retain existing data, remember to save the existing data to another file before downloading new data. The other option is to ALWAYS save the data to a new file after downloading.

3.17 Help
To obtain help for the software, click on the "Help" Tool Bar button.
The Help documentation will appear in PDF format.
3.18 Set Device ID

The Apex’s CPAP devices (for some models) have ID registration function for machine management. The ID of these devices can be set from the PC using the “Set Device ID” function.

- This function is only workable by using the USB cable, not the miniSD or SD card.
- Make sure the CPAP system is in standby mode, and the physical (cables) and internal connections (Serial Ports) between the CPAP device and computer has been established. Refer to 3.16 Download for details.
- Click the “Device ID” toolbar button and the Set Device ID Window will appear. The software will display the default number “000000” or if you have edited ID No. on the Patient Profile Tab, it will display the last 6 digits for the Device ID. You can reset the number and click the “OK” button to register the ID in the device.

![Set Device ID](image)

3.19 Set Clock

The Apex’s CPAP device has a real time clock that maintains the current time of the day. The real time clock on the CPAP device can be reset from the PC using the “Set Clock” function.

- When using this function, you must first make sure that your computer’s system date and time are correct.
- Make sure the CPAP device is in standby mode, and the physical (cables) and internal connections (Serial Ports) between the CPAP device and computer has been established. Refer to 3.16 Download for details.
- Click the “Clock” toolbar button and the Set Clock Window will appear. The software will display the system time from your computer. Click the “Set Clock” button to synchronize the time between Apex’s CPAP system with the PC.

![Set Clock](image)
3.20 Change Device Settings

Device settings can be changed via Easy Compliance Software by using a miniSD or SD card. **Note:** If patient data in the miniSD or SD card are not open, the function to change device settings via miniSD or SD card will not be enabled.

Function disabled if patient data in the miniSD or SD card are not open.

To change device settings, open patient data from the miniSD or SD card first and go to “Settings” (Menu Bar) -> "Change Device Settings via SD Card".

Browse the Card Location to root directory, ex. F:\. The current settings are shown in the upper section of the window. Change settings and press “Apply” and a window showing “Settings Applied Successfully” will pop up.
3.21 Patient Profile Tab & Clinical Details Tab

General patient information can be viewed from two of the Information Tabs at the bottom of the main menu. This includes the “Patient Profile” and “Clinical Details” tab. Both tabs have an “Edit” Button in the lower right corner that you can press to access an “Edit” screen where you can modify/add information.

Patient Profile View

Clinical Details View
3.22 Patient Notes Tab

The Patients Notes tab is a simple way to attach your own notes to the current patient file. To view and edit the patient notes, go to “Edit” (Menu Bar) -> "Patient Notes". When the “Patient Notes” window appears, you can click on any of the line items where you can add or edit your notes. The maximum number of notes is 20.
3.23 Total Time Tab

Total Time Tab displays a general overview of the device operating records for each day. The Total Time data has two sections. The left panel is the cumulated operating time for the device which is defined as the time airflow is flowing through the tube (whether or not the patient has donned the mask). The right panel shows the times during the day that the device was operating.

The Usage Profile Range (right panel) displays the time of day during which the device is running. A 24-hour period is shown as a horizontal bar, and starts at 12pm (noon) in order to capture one night on a continuous single line (since the devices is typically used at night).
### 3.24 Compliance Tab

Compliance Tab displays an overview of the compliance records for each day. The Compliance tab is composed of two sections; the left panel is the cumulated daily compliance time recorded for each day; the right panel is the times during the day that the patient is receiving treatment.

Compliance time is the time that the device is delivering airflow AND the patient is wearing the mask.

#### Compliance Tab

The Compliance Usage Profile Range displays the times during the day where the patient is receiving treatment. A 24-hour period is shown as a horizontal bar and begins at 12pm in order to capture one night on a continuous single line.

**Note:** In order to leave the patient enough time to settle into a relaxed state, the first 15 minutes of each session is not recorded by the Apex’s CPAP device.

**Note:** The compliance time and pressure data will be captured every 15-minute in the Apex’s CPAP system and user may turn off the device by pressing “START/STANDBY” button on the device. If a usage session is ended up by low pressure auto-off function instead of normally turning off manually, the compliance record shorter than 15-minute session will NOT be shown on the compliance view even though it is stored in the device memory. Therefore, there might be a few minutes difference in the meter record between software and the device LCD.
There might be a slight discrepancy between the information on the Compliance tab and the data on the Apex’s CPAP device. If, at the end of a usage session, there was a drop in pressure in the mask (mask slips off), the last few minutes of a 15-minute session may NOT show on the Compliance tab (though it is recorded on the CPAP device).

**View of cumulated daily compliance time**

### 3.25 Detail Data

The Detail data shows the latest 72-hour usage data including pressure, detected events and leak.

**Detail data, detailed information for sessions shown in the left graph is listed in the right column.**
Mark a specific session to enlarge the graph.

Graph of the specific session is enlarged. You can press the mouse right-click to undo zoom in.

The indication line can point out the pressure & leak at a specific time (numbers shown in the lower right corner).

In the pressure graph, the orange line shows the max. P level and the green line shows the min. P level.
3.26 Long Term Data

The Long Term data shows various statistical information regarding patient data. This tab is composed of three pages which are average pressure & leakage information, compliance & events. All three pages have two sections; the left panel is the daily pressure graph and right panel is the analysis data. This report only covers a date range configured from the Edit Long Term Report window. (see 3.14 Edit Long Term Report).
Pressure Graph
Pressure graph is a histogram that displays the average pressure levels delivered on any particular a day.

Analysis Data
Days –
1. “Total days”: Are the total number of days in the configurable range.
2. Number of Days: Are the total number of days the patient used the device and the total number of days the patient did not use the device.
3. % Days/Period: The percentage of days with device usage and without device usage.

Compliance (with usage) –
1. Total Compliance: The accumulated compliance time (in hrs and mins).
2. Average Compliance: The average daily compliance time per day.
3. Min. Compliance: The least amount compliance time for any one day (in hrs and mins)
4. Max. Compliance: The most amount of compliance time for any one day (in hrs and mins)
5. % days with usage >= x h/d: The percentage of days that reached a minimum number of compliance hours (this “minimum” is defined in Edit->Long Term report configuration options- 3.14)